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MayaMaya

•• Used in industrial design, CAD, computerUsed in industrial design, CAD, computer
games and motion picture effectsgames and motion picture effects

•• Special focus on motion pictures and gamesSpecial focus on motion pictures and games
•• The ambition is The ambition is ””what you see is what youwhat you see is what you

getget””
•• Being able to manipulate things directly in aBeing able to manipulate things directly in a

perspective view was quite new at the timeperspective view was quite new at the time
•• Alias/Wavefront Alias/Wavefront →→ Alias  Alias →→ Autodesk Autodesk

Main competitorsMain competitors

•• 3D Studio Max3D Studio Max, http://www.discreet.com/, http://www.discreet.com/
•• Cinema 4DCinema 4D, http://www.maxon.net/, http://www.maxon.net/
•• HoudiniHoudini, http://www.sidefx.com/, http://www.sidefx.com/
•• LightWaveLightWave, http://www.newtek.com/, http://www.newtek.com/
•• SoftImage XSISoftImage XSI, , http://www.softimage.com/http://www.softimage.com/
•• ZBrushZBrush, , http:http://pixologic//pixologic.com/.com/
•• Blender Blender (free), http/www.blender.org/(free), http/www.blender.org/
•• Alias, AutoCADAlias, AutoCAD

Graphical Editors used atGraphical Editors used at
CSC/Nada earlierCSC/Nada earlier

•• Constraint based editor, SCED, free Constraint based editor, SCED, free
•• Rhino, free Rhino, free
•• SunGV/SunVision SunGV/SunVision
•• Alias Alias

An An evaluation was done a few years ago between evaluation was done a few years ago between 3D3D
Studio Max and MayaStudio Max and Maya - we decided to go for Maya. - we decided to go for Maya.

What is Maya?What is Maya?

•• Tool for creating virtualTool for creating virtual
3D- or 2D models3D- or 2D models

•• RenderingRendering
•• AnimationAnimation
•• Special effectsSpecial effects
•• Different kinds of surfaceDifferent kinds of surface

representationsrepresentations

•• Think sculpting:Think sculpting:
creating form / shape!creating form / shape! Venus from Willendorf

22000-24000 B.C.
http://witcombe.sbc.edu/willendorf/

What is Maya?What is Maya?
•• Concepts Concepts in in Maya Maya are (are (more more or less) or less) common common to allto all

3D 3D tools tools ((workflowworkflow, , tool tool set, and GUI set, and GUI differsdiffers))
•• The same operation The same operation can can be be performed performed in in manymany

different different ways ways in in MayaMaya
•• Steep learning curveSteep learning curve
•• Very efficient workflow Very efficient workflow for for experienced usersexperienced users
•• We have used different versions, currentlyWe have used different versions, currently

Maya2008 (things here may include earlier versionsMaya2008 (things here may include earlier versions
which is also the case for which is also the case for webb webb info)info)

•• Help menus in Maya, learning movies, tutorial onHelp menus in Maya, learning movies, tutorial on
webbwebb, special search result on , special search result on webbwebb, e.g. On pivot, e.g. On pivot
points: points: http://www.http://www.expertvillageexpertvillage..com/video/41029_autodesk-maya-pivot-pointscom/video/41029_autodesk-maya-pivot-points.htm.htm
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Maya tool setsMaya tool sets

•• ModelingModeling
•• ShadingShading
•• LightingLighting
•• RenderingRendering
•• AnimationAnimation
•• Dynamics, particlesDynamics, particles
•• Character rigging and skinningCharacter rigging and skinning

The assignment

Project managementProject management

•• Maya proposes a work organization schemeMaya proposes a work organization scheme
(but does not enforce it)(but does not enforce it)

•• A Maya A Maya project project contains one or severalcontains one or several
scenesscenes

•• All scenes in a project share input resourcesAll scenes in a project share input resources
(such as texture images)(such as texture images)

•• The rendered output images for the scenesThe rendered output images for the scenes
in the project are stored in the same folderin the project are stored in the same folder

Project managementProject management

Name your project!
PRESS ”Use Defaults” BEFORE ”Accept”!

(Creates a very useful directory/folder structure.)
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The user interfaceThe user interface

Watch the Learning Movies!
Browse the Tutorials!
Use the Help System!

The WorkspaceThe Workspace

The menu barThe menu bar

Toolset-specific menus

"Polygons" should usually be active
(except e.g. when you associate

light sources with objects, 
more later)

Selection masks, snap, renderingSelection masks, snap, rendering

Tool boxTool box Channel box, layersChannel box, layers

Display / hide
channel box & layers.
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ShelfShelf Animation, timelineAnimation, timeline

Status/command line, help lineStatus/command line, help line Show / hide UI elementsShow / hide UI elements

Workspace layoutsWorkspace layouts

Pressing <SPACE> quickly toggles between 4-view and active view.
Choose different workspace layouts by 

clicking on the icons beneath the tool box.

ViewsViews

Create new view 
(perspective or orthographic)

Name your view!
(Click once in the 

entry field)

Choosing your new view
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ViewsViews

Show / hide different
entity types (per view)

ViewsViews

Rotate view
(perspective only):

Alt + left
mouse button.

Translate:
Alt + middle

mouse button.

Dolly in/ut:
Alt + right

mouse button.

ModelingModeling

•• NURBSNURBS
•• SubdivisionSubdivision

(Catmull-Clark)(Catmull-Clark)
•• PolygonsPolygons

Polygon modelingPolygon modeling

•• We use polygon modeling in the assignmentWe use polygon modeling in the assignment
•• Two main ways of working:Two main ways of working:

•• Create a primitive object and manipulate itCreate a primitive object and manipulate it
•• Create polygons one at time and manipulate thoseCreate polygons one at time and manipulate those

(possibly join together into an object)(possibly join together into an object)

•• The first way is simpler and more efficient for theThe first way is simpler and more efficient for the
assignmentassignment

•• Modeling requires imagination Modeling requires imagination –– both with both with
respect to form/shape and with respect to therespect to form/shape and with respect to the
tools you use!tools you use!

Creating primitive objectsCreating primitive objects

Position pointer in a view and press <F> to center
the camera on the objects.

Creating primitive objectsCreating primitive objects

Click on the object with the left mouse button to select it.

Press <Delete> to delete something you have selected.
Maya has an Undo facility (Ctrl-Z), but save often!

Use ”Save As...” so you can return to a previous stage 
in your work if you need to.

The channel box
shows the most 

important
attributes of 
the object.
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Nodes and attributesNodes and attributes

•• Objects in Maya are built from Objects in Maya are built from nodesnodes::
•• Creation node Creation node - records the options that- records the options that

created the objectcreated the object
•• Transform node Transform node - records how the object is- records how the object is

moved, rotated, and scaledmoved, rotated, and scaled
•• Shape nodeShape node - stores the positions of the - stores the positions of the

control points or vertices of the objectcontrol points or vertices of the object
•• Rendering nodesRendering nodes  –– stores information about stores information about

the appearance of the objectthe appearance of the object
•• Each node has Each node has attributes attributes associated with itassociated with it

Nodes and attributesNodes and attributes

The attribute editor shows
all attributes for a selected

object.

Choose a node using
the tabs and an attribute

group in the window beneath.

Nodes

Nodes and attributesNodes and attributes

In the channel box,
creation node attributes 

are shown under 
”INPUTS”.

Change these to modify the initial attributes of
the object.

Nodes and attributesNodes and attributes

The creation node parameters can
also be accessed by clicking 

the  button in the menu (this
button is called ”Tool options”).

Changes made here changes the
default creation node parameters.

”Apply” creates a new object and 
leaves the window open. ”Create”
creates a new object and closes

the window.

TransformationsTransformations

Translation (along coordinate axes)

Rotation

Scaling (along coordinate axes)

Keyboard shortcuts for tool box:
<Q>, <W>, <E>, <R> and <T>

TranslationTranslation

Move freely:
left-drag in the 
yellow square

Constrain to an axis:
left-drag one of the

axis arrows

Constrain to principal plane:
<Ctrl> + left drag one

of the axis arrows
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RotationRotation

Free rotate:
left-drag on object

Constrain to
camera plane:

left-drag yellow ring

Constrain to principal plane:
left-drag one of the other

three rings (red, green, blue)

ScalingScaling

Scale freely:
left-drag the yellow cube

Constrain to axis:
left-drag the

red, green, or blue cube

Constrain to principal plane:
<Ctrl> + left drag the 

red, green, or blue cube.

TransformationsTransformations

You can also enter values
directly into the transformation

node using the channel box
(or the attribute editor).

ComponentsComponents

Press and hold the right mouse button over an object to display
the menu (called a marking menu). 

Then drag onto a button to select which component type you wish to work with.

Entire object
(all components)

Components are the entities that make up the 
shape of an object:

Manipulating edgesManipulating edges

Choose edge components.
Select one or more edges.

Choose a transformation
tool.

Transform!

Manipulating verticesManipulating vertices

Choose vertex components.
Select one or more vertices.

Choose a transformation
tool.

Transform!
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Manipulating facesManipulating faces

Choose face components.
Select one or more faces 
(use the blue center dot).

Choose a transformation
tool.

Transform!

Pivot pointsPivot points

<↖> or <Insert> toggles between
transformation of the object and 
transformation of the pivot point.

Transformations are applied
at the pivot point.

There is one pivot 
point per object.

You often need to move
the pivot point.

Pivot pointsPivot points SnappingSnapping

Snap to
grids

Snap to
curves

Snap to
Points

(vertexes)

Snap to
view

planes

When transforming, the pivot point is snapped.

Snapping - exampleSnapping - example

Moving the pivot point
to a corner: 

choose snap to points.

Translate the pivot
point to the corner.

To move the cube
”onto” the X/Z plane:
choose snap to grids

and translate.

The gridThe grid

Change the grid parameters when needed.
Choose size and the number of lines ber unit.

Subdivisions = additional lines between each unit line.
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GroupsGroups

Select two or more objects:
<Shift> + left click

Choose Edit→Group
(or Ctrl+G) to

create a group.

The pivot point for the group
is placed at the center of 

one of the objects
(not between the objects as

above, previous version)

GroupsGroups

Manipulate or
select groups

Manipulate or select 
individual objects 

(inside or outside groups)

Manipulate or select
object components

(inside or outside groups)

The component type to be 
manipulated or selected

Vertices, edges, and faces.

GroupsGroups

The outliner window shows all group hierarchies.
It also shows other entities that are part of the project.

You can select groups and objects by choosing them in the outliner window.

LayersLayers

Layers are used to hide or ”lock” 
objects so that they don’t get in the way 

or are modified by accident. 
Window → General Editors → Display Layer Editor

to display layer editor
(some changes menues in new version)

Always name your layers!

LayersLayers

Visible / invisible Lock / unlock

T = lock + template
(display objects in
low level of detail)

R = lock + reference
(display objects in
high level of detail)

Layer color
(double click
to modify)

Name your
layer!

(double left-click
the name)

Duplicating objectsDuplicating objects

Choose the number of copies and
the transformation Maya should

perform before each copy is made.
The new copy is automatically

selected when it has been created.

The ”Instance” option associates
the copies with the original so that

changes made to the original is
automatically made to the copies.
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Duplicating objects - exampleDuplicating objects - example

Create a stairway step.
Move the pivot point to the side.
Translate up and rotate around y

axis as duplication options.

Boolean operationsBoolean operations

Select two objects
(MUST be closed).

Choose an operation.

Extruding facesExtruding faces

Select a face.
Select ”Extrude

Face” in the menu.
This creates a new
face in the same

plane as the
original face.

Manipluate the
size and position
of the new face

Creating individual polygonsCreating individual polygons

Click to position each
vertex. Remove a vertex

using <Backspace>.

Press <Enter>
when done.

Merging verticesMerging vertices

The tolerance level can be modified
using the tool options ().

Objects may have to be
combined first (Mesh→Combine),

see next slide

Combining polygons into an objectCombining polygons into an object

Select the polygons.
Merging vertices and edges

before combining is
recommended!

Choose ”Combine”. The result is a new
object with

creation history...
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Combining polygons into objectsCombining polygons into objects

If you delete the creation
history...

...the polygon surface
is all that remains – the new object is

equivalent to the other primitive
objects (sphere, cube, ...).

Shaders Shaders and texturesand textures

Surface appearance in Maya is specified using shaders.
A shader consists of a render node network.

There are three types of render nodes: material nodes,
texture nodes and positioning nodes.

Each shader must have a material node.

Shaders Shaders and texturesand textures

The ”Hypershade” window is the ”work area”
where shaders are created.

HypershadeHypershade

All shaders in the current
scene.

Work area where new
shaders are created and
modified.

Material nodes.
(Some correspond

to reflection
models.)

Creating a Creating a shadershader

1. Choose a
material node to

create a new
shader.

2. Double click the
new shader in the

work area.

3. Modify the
attributes for the
material node.

Name 
your 

shader!

Assigning Assigning shaders shaders to objectsto objects

Assigning a shader to objects:
1) Select the object(s). Click-hold the right mouse button over the
shader in Hypershade and choose ”Assign Material To Selection”.
2) Click-hold the right mouse button on an object and choose
”Materials→Assign Existing Material”. (Only works for a single
object at a time.)
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TexturesTextures

Click the checkerboard
button for the color

attribute.

This will create a new
texture node and

connect it to the material
node.

Choose ”File”. Select an image file.

Put your texture files
in the

”sourceImages”
folder for your

project!

Texture positioningTexture positioning

UV points are assigned to each vertex.
The values are then interpolated across the surface.

v

u
0 1

1

0

Texture positioningTexture positioning

Maya assigns UV points automatically to polygons (using a positioning
node in the shader), but the result is almost always haphazard.

So we need to set the UV points ourselves!

Select the object(s) and choose a mapping.
Use the tool options () to set the mapping parameters first!

The mapping is stored in a separate projection node (outside the
shader network, since it belongs to the object(s) and not the shader).

Texture positioningTexture positioning

Planar Cylindrical Spherical

Texture positioningTexture positioning

You can choose the
mapping in the channel
box (under INPUTS) if

you want to change the
projection attributes.

You can also press the ”Show
Manipulators Tool” button in the

tool box to manipulate the
projection interactively.

Surface Surface normalsnormals

Normals are assigned to vertices and interpolated
across the surface.

Vertex normals can be set to the
surface normal ("Harden Edge") or

be averaged across surfaces ("Soften Edge").
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LightsLights

Directional Point Spotlight

Ambient

LightingLighting

•• Lighting is an art form!Lighting is an art form!
•• ””Simulating realitySimulating reality”” seldom leads to interesting seldom leads to interesting

images!images!
•• Professionals often use Professionals often use ””negativenegative”” light sources to light sources to

remove light from the sceneremove light from the scene
•• As in illustration, the key role of the light is toAs in illustration, the key role of the light is to

bring out form/shapebring out form/shape!!
•• Think Think ””painting with lightpainting with light””!!
•• Think about the color scheme and the general feelThink about the color scheme and the general feel

of your image!of your image!

Three point lightingThree point lighting

•• Classic imaging techniqueClassic imaging technique
•• Key lightKey light: most: most

important, brings out theimportant, brings out the
main shapemain shape

•• Fill lightFill light: takes the edge: takes the edge
off shadow regions, bringsoff shadow regions, brings
out shape in shadowout shape in shadow
regionsregions

•• Back lightBack light: accentuates: accentuates
the silhouettethe silhouette

http://www.andrew-
whitehurst.net/3point.html

http://www.3drender.com/
light/3point.html

Creating light sourcesCreating light sources

Light sources are moved and oriented in the same way as objects.

Light source attributesLight source attributes

Select the light source. The
most important attributes
are shown in the channel

box.

The other attributes can be
modified using the

attribute editor.

Light linkingLight linking

Sometimes, you don’t want an object to
be lit by a light source.

Disconnect light sources from objects in
the ”Light Linking” window. (Need to
choose ”Rendering” to see the menu.)

Grey line on the right = light is ”on” for
the selected (grey) objects on the left.
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RenderingRendering

•• Two types:Two types:
•• Ray tracingRay tracing
•• Ray castingRay casting

•• Ray tracing allows for reflection, refraction,Ray tracing allows for reflection, refraction,
and high-quality shadows, but is slowand high-quality shadows, but is slow

•• Ray casting is faster, but uses textures forRay casting is faster, but uses textures for
shadows and reflections (which may lead toshadows and reflections (which may lead to
aliasing)aliasing)

RenderingRendering

Render image
(of the

currently
selected
view)

Render image
that allows for

interactive
updates

(more later)

Open the general
rendering attributes

window:
”Render Globals”

Render Render globalsglobals

Important fields:

Image Format (use JPEG)

Resolution (of the output
image)

Anti-aliasing quality

Raytracing quality

Render Render globalsglobals

To use ray tracing (rather
than ray casting), check

the ”Raytracing” box under
”Raytracing Quality”).

Choose the recursion depth
for reflections and

refractions: 1-2 is usually
enough.

ShadowsShadows

A light source does NOT cast
shadows unless shadow

casting has been activated!

Select the light and activate”Ray
Trace Shad” (if you want to use
ray tracing) or ”Depth Map Sha”
(if you want to use ray casting).

The objects also need to
receive/cast shadows (which is
the default, but can be changed

in the attribute editor).

Interactive renderingInteractive rendering

Turn off ray tracing. Click the IPR-button. When the rendering is
complete, select a region. It is now possible to update light sources
(position and other attributes) and shaders. The region is updated

automatically.

IPR creates large files in the renderData/iprImages folder!
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AnimationAnimation

•• Maya supports Maya supports keyframingkeyframing, , dynamicsdynamics,,
and and inverse kinematicsinverse kinematics

•• More on dynamics and inverse kinematics inMore on dynamics and inverse kinematics in
animation lecture...animation lecture...

•• KeyframingKeyframing::
•• Set object attributes at specific Set object attributes at specific key frameskey frames
•• Computer Computer interpolates interpolates the attribute valuesthe attribute values

((in-in-betweeningbetweening  or "or "tweeningtweening")")

AnimationAnimation

Choose "Animation" to display animation-specific menus.

Choose total number of frames for the animation.
Assume 24 frames per second.

Select a frame in the time slider.

Setting key framesSetting key frames

Select the objects you wish to set a keyframe for, 
then do "Animate→Set Key".

Red lines in the time slider indicates
where keyframes have been set.

KeyframingKeyframing

Choose a new frame, manipulate the
object(s), and set a new key frame.

Play animation using the
animation controls.

To set the animation speed to
24 fps, open animation prefs,
select "Timeline" and choose

"Real-time (24 fps).

Interpolation curvesInterpolation curves

Select a layout with a graph
to show the

interpolation curves.

These curves illustrate how the object
attributes change over time.

By default, the changes are smoothed.

Interpolation curvesInterpolation curves

To create a "sharp" 
interpolation, select the 

attribute, choose a 
key frame and press the 

"sharp" icon.

To change the tangent 
interactively, selecting it,
press 'w' to activate the 

move tool,
and drag with the 

middle mouse button.

Break the tangent by
clicking the 

"break tangent" icon.

Join tangents together 
by clicking

the "unify tangents" icon.


